
NEWSLETTER #96 - November 2020

Just another tiny newsletter this month… 
As we near the end of the year, the ever-expanding newsletter just refuses to get smaller.

This month, we look at Excel and MDX performance improvements, we revisit Power Query Data Types and take a look at the new 
Power BI experience in Microsoft Teams.

We also have our monthly regulars Beat the Boredom to give you your monthly financial modelling challenge, Visual 
Basics, Power Pivot Principles, Power Query Pointers, Power BI updates for Uncle Tom Cobley et al, the usual keyboard 
shortcuts, plus we decide to FDIST and dat with the continuing A to Z of Excel Functions.

Happy reading and remember: stay safe, stay happy, stay healthy.

Until next month.
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Excel Performance Improvements
These days, we always seem to be providing information and insights on 
all the new and wonderful things going on in Power BI.  But for many of 
us, Excel represents both the starting and stopping points of our financial 
analysis.  Therefore, it’s good to know Microsoft has been hard at work 
making improvements in Excel too.

Things have moved on significantly since the first wave of lookup 
performance improvements just over three years ago now (tempus fugit 
indeed!).  

Aggregation functions

Aggregation functions like SUMIFS, COUNTIFS, AVERAGEIFS, MAXIFS, 
MINIFS and their singular counterparts like SUMIF, COUNTIF and 
AVERAGEIF are among Excel’s most frequently used functions.  If you use 
them to aggregate items in a table or range in Excel, and see it noticeably 
take time in seconds or minutes or more, chances are you will now see 
very noticeable improvement in the speed at which you see results.

They now evaluate more quickly since Microsoft has made the evaluation 
of each expression for a range of cells more effciient.  Now, Excel creates 
an index on-demand when you first search a range of cells for an 
expression and then reuses it in subsequent aggregations pulling from 
the same range, until data changes in the lookup range.

The effect is dramatic.  For example, calculating 1,200 SUMIFS, AVERAGEIFS, and COUNTIFS formulae aggregating data from 1 million cells on a 4 core 
2 GHz CPU that took 20 seconds to calculate using Excel 2010, now only takes eight (8) seconds on Excel M365.
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Real Time Data

More VLOOKUP, HLOOKUP and MATCH improvements

RealTimeData (RTD) is commonly used by customers to get real-time 
data from, say, the stock market.  If you use them directly in your 
workbooks to get real-time data directly in, and see it noticeably take 
time in seconds or minutes or more, chances are you may now see 

noticeable improvements in the speed I which the results render, since 
Excel’s in-built RealTimeData (RTD) function has now been sped up many 
times over.

In Office 365 version 1809 and later, Excel's VLOOKUP, HLOOKUP and MATCH for exact match on unsorted data are all much faster than previously 
when looking up multiple columns (or rows with HLOOKUP) from the same table range.

This has been achieved by removing bottlenecks in Excel’s underlying memory and data structures, as well as making it “thread-safe” to allow it to 
be calculated on all available threads of Multithreaded recalculation (MTR).  An after effect of making it thread-safe is that MTR doesn't need to be 
paused to run RTD function anymore, which improves performance noticeably when calculating it along with lots of other calculations.

As examples:
	 1.	 simulating 125,000 RTD updates for stock topics like "Last Price", "Ask", "Bid" to calculate values like "Trade Volume", "Market Value", 	
		  "Trade Gain/Loss" etc. in 500,0000 cells in all, took 47 seconds using Excel 2010, yet only seven (7) seconds using Excel M365, on the same 	
		  hardware

	 2.	 running a workbook with 10,000 RTD and 10,000 VLOOKUP functions, with each VLOOKUP depending upon an RTD function result.  Without 	
		  thread-safe RTD, full recalcuation took 10.20 seconds and with thread-safe RTD, it took 5.84 seconds.

These lookup functions now create an internal cached index for the 
column range being searched. This cached index is reused in any 
subsequent lookups that are pulling from the same row (VLOOKUP and 
MATCH) or column (HLOOKUP).  The effect is again dramatic: lookups on 

five different columns in the same table range can be up to four times 
faster than the same lookups using Excel 2010 or Excel 2016, and the 
improvement grows ever larger as more columns are looked up.
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For example, calculating 100 rows of these 5 VLOOKUP formulas took 37 seconds to calculate using Excel 2010 and only 12 seconds using Excel 2016:

=VLOOKUP($A900000,$A$2:$E$1000000,1,FALSE)

=VLOOKUP($A900000,$A$2:$E$1000000,2,FALSE)

=VLOOKUP($A900000,$A$2:$E$1000000,3,FALSE)

=VLOOKUP($A900000,$A$2:$E$1000000,4,FALSE)

=VLOOKUP($A900000,$A$2:$E$1000000,5,FALSE)

LAA memory improvement for 32-bit Excel

Although the 64-bit version of Excel has large virtual memory limits, the 
32-bit version has only 2 GB of virtual memory.  Some users employ the 
32-bit version because some third-party add-ins and controls are not 
available in the 64-bit version.

The 32-bit versions of Excel 2013, Excel 2016 and Excel 2019 now have 

Large Address Aware (LAA) enabled.  This should minimise out-of-
memory error messages.

LAA doubles available virtual memory from 2 GB to 4 GB on 64-bit 
versions of Windows, and increases available virtual memory from 2 GB 
to 3 GB on 32-bit versions of Windows.

Full column references

In earlier versions of Excel, workbooks using large numbers of full column references and multiple worksheets (for example 
=COUNTIF(Sheet2!A:A,Sheet3!A1)) might use large amounts of memory and CPU when opened or when rows were deleted.

Excel 2016 Build 16.0.8212.1000 reduces the memory and CPU used in these circumstances.

In a sample test on a workbook with six million formulae, using full column references failed with an out-of-memory message at 4 GB of virtual 
memory with Excel 2013 LAA and with Excel 2010, but only used 2 GB of virtual memory with Excel 2016.
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Structured references

In Excel 2013 and earlier versions, editing tables where formulae in the workbook use structured references to the Table was slow.  This led to the 
perception that Tables should not be used with large numbers of rows.  This issue no longer occurs in Excel 2016 and later.

For example, an editing operation that took 1.9 seconds in Excel 2013 and Excel 2010 took about 2 milliseconds in Excel 2016 and Excel 2019.

Filtering, sorting and copy / pasting

Microsoft has also made a number of improvements to the response 
time when filtering, sorting, and copying / pasting in large workbooks.

In Excel 2013, after filtering, sorting or copying / pasting many rows, 
Excel could be slow responding or would even hang.  Performance was 
dependent upon the count of all rows between the top visible row and 
the bottom visible row.  These operations are noe much faster after the 
internal calculation of vertical user interface positions was improved in 
Build 16.0.8431.2058 onwards.

Opening a workbook with many filtered or hidden rows, merged cells, or 
outlines could cause high CPU load.  A fix has now been introduced from 
Build 16.0.8229.1000 onwards.

After pasting a copied column of cells from a table with filtered rows 
where the filter resulted in a large number of separate blocks of rows, 
the response time was very slow.  This has been improved from Build 
16.0.8327.1000.
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A sample test on copying / pasting 22,000 rows filtered from 44,000 rows showed a dramatic improvement:

	 •	 for a table, the time went from 39 seconds in Excel 2013 and 18 seconds in Excel 2010 to 2 seconds in Excel 2016 and Excel 2019
	 •	 for a range, the time went from 30 seconds in Excel 2013 and 13 seconds in Excel 2010 to instantaneous in Excel 2016 and Excel 2019.

In Excel 2013, copying / pasting cells containing conditional formats could be slow.  This has been significantly improved in Excel 2016 Build 
16.0.8229.0 onwards.

A sample test on copying 44,000 cells with a total of 386,000 conditional format rules showed a substantial improvement:

	 •	 Excel 2010: 70 seconds
	 •	 Excel 2013: 68 seconds
	 •	 Excel 2016 / 2019: 7 seconds.

When adding and deleting large numbers of worksheets, a sample test on Excel 2016 Build 16.0.8431.2058 shows a 15% – 20% improvement in speed 
compared to Excel 2013, but 5-10% slower than Excel 2010 (sadly).

Copying conditional formats

Adding and deleting worksheets
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Microsoft has also improved many other instances where they have received feedback about Excel being slow, freezing, not being responsive when 
opening a file / pasting / inserting / deleting / coding VBA / sharing Excel in Teams, etc.

Here is a summary of what else has been improved / rectified:

	 •	 Faster opening workbooks with many user defined functions (UDFs).  You may have noticed opening workbooks with many UDFs including 	
		  those from add-ins might be slower than a “conventional” workbook.  This was because Excel employed an inefficient linear scan search to 	
		  lookup every UDF found in the workbook.  This has now been replaced with a more efficient cache and search to make this lookup much 	
		  faster now

	 •	 Faster large paste operations using the clipboard. If you saw noticeable delays in pasting large content like HTML, images, objects etc. into 	
		  Excel, you should now see this has now become quicker.  The underlying content streaming data structure has been made more efficient and 	
		  responsive

	 •	 Speeding up deleting ranges that include merged cells.  Reason No. 12,477 for not using merged cells!  In the case of merge cells, it was 	
		  discovered that Excel would inefficiently iterate through the rows in the ranges multiple times before deleting.  This repetition has been 	
		  removed

	 •	 Faster insertion of a column in a sheet when rows are filtered.  Believe it or not, Microsoft unearthed that this happened especially 	
		  when the sheet had thick borders!  Evaluating borders thickness is apparently an expensive operation.  This was compounded with the 	
		  identification that the operation may be performed incorrectly for hidden or filtered rows too.  Now fixed!

	 •	 Faster recalculating user defined functions (UDFs) in VBA.  When VBA UDFs are calculated, they update the VBA Editor’s state (title bar, 	
		  output window, etc.).  This is very expensive from a reource perspective, and worse, this slow performance continued even after closing the 	
		  Editor window.  Closing the VBA Editor window has removed this overhead

	 •	 Better sharing of Excel Application Window from Teams.  You may have noticed that after sharing Excel Application Window from Teams 	
		  and working in it, it may start to freeze.  This was due to Excel “leaking” resources.  Microsoft has called the plumber, the leak has been 	
		  fixed, and the freeze has been eliminated

	 •	 Faster operations in worksheets with large number of formulae spanning a range of cells.  When performing some operations (for example 	
		  ‘Convert to Number’), Excel was needlessly iterating over structures for frequently used formulae within the workbook.  This unnecessary 	
		  work has now been eradicated

	 •	 Faster ‘Check For Errors’ on large sheets with many errors.  When a table contains tens of thousands of rows as well as empty cells, Excel 	
		  would generate an inefficient data structure of every error and for each iteration for an error.  In the worst case, Excel would run for very 	
		  long periods of time or hang, consuming high CPU and memory.  Microsoft has now developed an efficient data structure.  Once created and 	
		  used, it returns results in seconds which previously would have taken many minutes, if not hours

	 •	 Faster invoking ALT + shortcut key functionality in Excel.  There used to be a slight delay when using ALT + shortcuts.  This was caused by the 	
		  wait to show the ToolTip windows.  This is unnecessary for expert users.  Now, Excel no longer waits for the ToolTip windows, allowing users 	
		  to type shortcuts much faster

	 •	 Faster international string comparisons.  String comparisons are common within Excel.  International string comparisons have been sped up 	
		  by optimising the code that performs these comparisons.

Other highlights
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Beat the Boredom Challenge

Visual Basics

With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls you can make before you reach your data 
limit.  Perhaps they should measure data allowance in mugs of coffee.  To 
try and keep our readers engaged, we will continue to reproduce some 

of our popular Final Friday Fix challenges from yesteryear in this and 
upcoming newsletters.  One suggested solution may be found later in this 
newsletter.  Here’s this month’s…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we consider just how well you can hide...  

As head into November, we know Black Friday happens on the Friday after American Thanksgiving. How would you know the date of Black Friday for 
any given year? Can this be done in one line? 

The longest period that can occur without a Friday the 27th is fourteen 
months, either from July to September the following year being a 
common year starting on Tuesday (e.g. 2001/02, 2012/13 and 2018/19), 
or from August to October the following year being a leap year starting 
on Saturday (e.g. 1999/2000 or 2027/28).

So this month’s challenge is simple: can you calculate when the next 
Friday 27th is without having to look at full calendars or consulting the 
internet?  Or for that matter, Friday of any date?

Sound easy?  Try it.  One solution may be found later in this newsletter 
– but no reading ahead!  

Over the next few articles, we’re going to cover a range of Events.  
These are the actions that can trigger when something happens, such as 
opening a file, changing sheets, selecting certain cells, and so on.

Let’s take a look at one of the most common Event macros: the Disclaimer 
macro.

The Disclaimer macro is commonly used to force people to enter the file 

on a ‘landing page’, usually containing some key details that people are 
required to agree to before using the file.  Of course, like most popups in 
Excel, I think people generally won’t read it anyway, so they’ll be happy 
to sign away their rights to sue, agree that their inputs belong to you, 
and to give you their first born child, right?

The place to start setting this up is in the “ThisWorkbook” section of the 
Project Explorer window:
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The actual subroutine can be selected by using the dropdown items at 
the top of the code window.  On the left-hand side, choose ‘Workbook’ 
to access an expanded dropdown box on the right.  By default, the 
right-hand side will change to Open, though you can choose a different 

event instead if you want.  Also, by default, a subroutine will be created 
called ‘Workbook_Open’, allowing you to specify what happens when 
workbooks are opened.

The reason we have to make sure the Disclaimer page is visible is because 
there must always be at least one visible worksheet in the workbook.  If 
it starts off hidden, and then you will reach an error if the macro tries to 
hide all of the other sheets without first unhiding the disclaimer.

The other thing to be aware of is the Very Hidden status of the other 

sheets.  There’s little point in having a disclaimer that can easily be 
circumvented by right-clicking on the sheet name and unhiding the 
sheets!   Therefore, it’s a good idea to set the Visible property to Very 
Hidden to be sure that people can’t easily unhide the sheets again.

The code that we’re going to use is as follows:

Private Sub Workbook_Open()

Dim ws As Worksheet

Sheets("DisclaimerSheet").Visible = xlSheetVisible

For Each ws In Sheets

    If ws.Name <> "DisclaimerSheet" Then

        ws.Visible = xlSheetVeryHidden

    End If

Next ws

End Sub

The code, line for line, equates to:

	 •	 declare a Worksheet variable called ‘ws’
	 •	 make sure the ‘DisclaimerSheet’ sheet is visible
	 •	 start looping through all of the worksheets in Sheets (i.e. all sheets in this workbook)
	 •	 check if the name of the worksheet is not ‘DisclaimerSheet’ (i.e. don’t hide the disclaimer sheet)
	 •	 if it’s not, change the sheet status to Very Hidden
	 •	 close the If statement
	 •	 close the For loop.

Then, once they’ve read the disclaimer, you can get them to click on an ‘I agree’ button that runs a similar macro:

Private Sub Unhide_All()

Dim ws As Worksheet

For Each ws In Sheets

    ws.Visible = xlSheetVisible

Next ws

End Sub

… which will unhide all of the sheets in the file again.

Of course, this requires the person receiving the file to enable macros, meaning that if they choose not to enable, they may well be able to use the 
file directly without it hiding all of the sheets.  Next time, we’ll look at the other side of the equation – setting up a macro to hide everything in a file 
before it saves.  

More next time.

The general steps to follow for a disclaimer macro work as follows:

	 •	 make sure that the disclaimer page is visible
	 •	 run through each of the sheets
	 •	 if the sheet is anything but the Disclaimer page, then set it to be Very Hidden.
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Power Pivot Principles
We continue our series on the Excel COM add-in, Power Pivot.  This month, we look at multiple tables.

Previously, we have talked about how filters are a more transparent way of filtering the data compared to entering filters directly into the CALCULATE 
measure.  For example, say we have a simple PivotTable:

Imagine we want to filter the PivotTable by year; to do this, drag the ‘Year’ field into the ‘Filters’ area, viz.

A ‘Filters’ row will appear allowing us to select which years we want to be displayed in the PivotTable.
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If we select 2016 and 2017,

the PivotTable will filter out all other years from the data. 

The filter will then change from ‘All’ to ‘(Multiple Items)’, clearly stating that the data 
is filtered.  Ergo, it is a more transparent method of filtering, instead of having filters 
applied directly in a measure.  It depends whether or not you require the filter to be 
part of the PivotTable context or not.

More Power Pivot Principles next month.

Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
some of the issues that can come up when using Power Query, and how to resolve them.

Sometimes, you are happily working away in Power Query when you hit a problem.  Features are not there when you need them, something we’re 
sure should have worked doesn’t.  The examples featured here do not form an exhaustive list, but these are some of the issues that we have 
encountered. 

Where is the Power Query Tab?

Thankfully, now eradicated by the inclusion of Power Query as the ‘Get 
and Transform’ section in the Excel 2016 menus, users of earlier versions 
of Excel can sometimes find that the Power Query (or the louder POWER 
QUERY) tab has disappeared.  This has happened to us (too?) many 
times, and to date, it hasn’t led to us losing any of our data.  The steps 
to get it back are listed on the Microsoft help pages (a good indicator 
of how often it happens!).  According to Microsoft, it is usually caused 
by the Excel COM add-in failing to load – this can happen after Excel 

encounters an error and has to close and re-open.

The steps to solve it are as follows.

From the Excel workbook, click the ‘File’ (or ‘FILE’ if you like Excel 
2013 SHOUTING at you) tab.  On the File menu, select ‘Options’, which 
displays the ‘Excel Options’ screen.  At the bottom of this screen there is 
a ‘Manage’ section as shown below; choose ‘COM Add-ins’:
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Click ‘Go’ to see if Power Query is on the list (see later for what to do if it isn’t).

Once you check the box next to ‘Microsoft Power Query for Excel’, click ‘OK’ and you should see the ‘POWER QUERY’ tab.

Success, ‘POWER QUERY’ is back, and any queries will be accessible.

Of course, as with any problem to do with computers, the simplest solution can be to ‘switch it off and on again’, which I recommend before trawling 
though help online to find the answer!  If the add-in is missing from the COM Add-ins list and a reboot has been tried, then upload Power Query 
again from the Microsoft website.

Where are my queries?

This one is much easier – in Excel 2016, 
there is a setting on the Data tab in the 
‘Get and Transform’ section to show any 
queries in the workbook (in previous 
versions of Excel, look for ‘Show Pane’ 
in the ‘Power Query’ tab): >
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Where is my Formula Bar?

Why didn’t that merge work?

In the Query editor, there is a View tab, which will allow some formatting options, including hiding the Formula Bar.  If it is missing, make sure this 
box is checked. 

Sometimes, it is easy to get so engrossed in getting to the next step that you don’t pay attention to making sure the current step is correct.  We came 
across this one whilst working once.  I was trying to apply an inner join to my merge and I had the following screen:

I couldn’t choose ‘OK’.  And this is where I deviated from where I should have gone.  I decided to refresh my data using the refresh icons next to each 
table:
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Now, the ‘OK’ button is available, so focused on getting to the result, I clicked on it:

Well it says it’s merged, but it looks like the first table.  And it is, because a step was missed:

I didn’t select any matching columns to 
link my tables!  But because I refreshed, I 
managed to bypass the security to make 
sure at least one linked column is selected.  
If I pick FULL_NAME in each table, and click 
‘OK’, the results look a little better:
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Ideally, the screen should have checks to stop me from clicking ‘OK’, even if you refresh, but I was able to bypass the security.  If I get unexpected 
results using any of the Power Query functionality, then it is worth going through what you have done step by step to see if it all makes sense.  
Merging tables with no instructions on how to join them does not make any sense.

Why didn’t that formula work?

This happens frequently.  You have entered a formula in the Advanced 
Editor, and it just doesn’t work, even though it looks right (sometime 
even when it tells you ‘No syntax errors have been detected’!).  There 
are a couple of ways this may have been caused.  The easiest one 
to replicate here is by copying lines of M language from a different 

type of editor.  Especially one with internal formatting (and escape 
sequences).  Word in particular has a different format for speech 
marks [“], which will not work in the advanced editor.  In the screen 
below, I have copied the last line from Word, and received the error 
message ‘Invalid Literal’:

To correct it, you need to delete the speech marks in the last line and type them in from the editor. 

And then the editor is happy.  Not all errors are easy to spot – sometimes you may end up with a line that looks fine, but is not acceptable.  The screen 
below looks okay – no syntax errors, so we must have created the code correctly, yes?

#  Invoked Custom Function”

”
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Well… actually, no!  The syntax checker is happy, but in the editor, the names of objects are not checked:

There was an extra space in ‘ Invoked Custom Function’ so it wasn’t recognised.  When you have a line of code which doesn’t pass the syntax or 
further checks and you are fairly sure you have the right functions and objects, then usually try to delete and retype that line – M language is not only 
case sensitive, but it does not like escape characters or other fonts. 

[Editorial note: Liam Bastick would like to add to the observations on M code: he advises would-be coders to image that M was written by your ex.  
And your ex hates you…]

More next month!

Power Query Extra: Power Query Data Types
We thought it was about time to review the recently-announced availability of Power Query data types in Excel.  With this feature, you can create 
custom data types from any data source and load them into Excel grid as rich data types.  Here’s how.

First of all, start with importing a data set using Power Query in the usual way (we’re using the good ol’ Contoso dataset as an example):
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In the Power Query Editor, select the relevant columns, and then click the ‘Create Data Type’ button on the Transform tab.

Define the data type name and choose a display column.
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Notice that the selected columns are collapsed into a single data type column.  Click the ‘Close and Load’ button on the Home tab to load the query 
into Excel. 

You can then explore the output of the query in Excel, with interactive data cards and formulae that reference your rich data types.

It’s easy to interact with the data types:

Check out the data type fields by clicking the     icon, and then open the associated card.  Further, you may extract fields to the grid by clicking the    	
	 button.  You may use the data type fields in Excel formulae by simply referencing to a cell with a data type. 

To use Power Query Data types in Excel, you must meet the following requirements: 

	 •	 you are in an organisation with Microsoft 365 / Office 365
	 •	 you are using Excel for Windows
	 •	 this feature is available to Insiders Current Channel (Preview) (we love even Microsoft don’t refer to their products correctly!) users 		
		  running Version 2010 Build 13328.20154 onwards.

New and Improved Power BI Experience in Teams
COVID-19 is changing how we work dramatically.  Many of us are working 
from home now, emphasising the need for greater remote collaboration.  
This, combined with social media, now means you can have thousands of 
friends without having a single friend!

With this all borne in mind, Microsoft has announced new Power BI 
integrations for Microsoft Teams, to make it easier to discover and use 
data within your organisation.  Indeed, since early October, the Power BI 
app for Teams is now available to commercial cloud customers. 
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In summary, here is a quick overview of the capabilities out now:

	 •	 new Power BI App for Teams that helps you view and work with Power BI content
	 •	 new Teams Search experience to find and open Power BI content
	 •	 new Teams Chat experiences to quickly find and share Power BI content
	 •	 new Dataset Discovery experience to help find data to create reports and Excel workbooks
	 •	 start a Chat in Teams when viewing reports and dashboards.  Send links to channels and chats, including the specific filters / views to speed 	
		  up conversations
	 •	 add a Power BI Tab to your channel and group chats.  Make it easy to find reports your Team uses frequently.

The last two features have been around a while, but let’s take a closer look at the others.

The Power BI app for Microsoft Teams shows the Home tab for the user with access to favourites, frequently viewed items, recently used features, 
and featured content.

Now, you can view and access all your Power BI content from Teams.  You can view reports, dashboards and apps right from Home.  There is no 
apparent need to go to Power BI in a browser.

To use the app, search for it in the Apps experience in Teams, and then:

	 1.	 click on “…” in the Teams Left Navigation
	 2.	 search for “Power BI”
	 3.	 select the Power BI app.

New Power BI app for Microsoft Teams (Preview)

The new Power BI app enables users to quickly discover, search and discuss data without ever leaving Teams.  This central, personalised home for 
data in Teams will ensure that insights are always just a click away from where conversations are happening and where decisions are made.
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This opens the Power BI app in Teams.  You will then obtain access to all of the Power BI reports, apps and dashboards you would otherwise have 
access to in Power BI.

To help you keep the app available, pin it to the Team left navigation bar:

	 1.	 right-click the Power BI icon on the left navigation of Teams
	 2.	 select Pin.

New Teams Search Experience

With the new Search experience in Teams, you can quickly find recent reports, dashboards and apps, and open them within the Power BI app for Teams.

To enable this feature:
	 •	 in the Teams Search bar type “@Power BI”
	 •	 pick from the list or type something to search for
	 •	 select the item
	 •	 press ‘Open’.

The first time you use this capability you’ll need to sign-in.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

For example, you can mention @Power BI in the Microsoft Teams search bar to find reports, dashboards, and apps.

Initially the item will open in a web browser, but when the roll-out completes the links will open in the Power BI app for Teams.  Again, you will need 
to sign-in to use the search capability and the message extension capability (below).  Just press the sign-in button and go through the wizard to start 
using the capability.

New Teams Chat experiences

In Teams, you may now send links to Power BI reports, dashboards, apps and workspaces directly.  To do this:

	 •	 find the Power BI icon at the bottom of the conversation
	 •	 if it’s not there, open the “…” and search for Power BI
	 •	 in the menu that opens, search for the item you want
	 •	 you will see items you recently used in the list ready to be shared
	 •	 a rich preview card is added to the message for you
	 •	 type your message or just press send so your colleagues get the link.

As before, the first time you use this capability you’ll need to sign-in.
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Until the roll-out has completed, you may experience very basic settings.  Microsoft assures there is a “better experience” on the way.

You can also find and add a Power BI report to a conversation in meeting chats too:

	 1.	 open the meeting chat
	 2.	 select the “…” menu
	 3.	 select ‘Messaging extensions’.

You may then search for or pick ‘Power BI’ from the list.

With ‘Chat in Teams’ you can send links to reports and dashboards directly to specific people, channels or meeting chats.  The links keep all the filters 
and slicers you apply in your Power BI report, so that when recipients open the link, they will see the exact data points you want them to see.

In fact, this capability has been available in the Power BI service since May 2020.  However, now, the links open directly in the Power BI app, so users 
don’t have to leave Teams to view the item.

To set this up:

	 •	 open a report, app or dashboard
	 •	 press ‘Chat in Teams’
	 •	 in the ‘Share to teams’ dialog, enter a channel, one or more people, or a meeting name.
	 •	 press ‘Send’
	 •	 recipients may then open the link.

It should be noted that you may need to press ‘Share’ first to give the recipients permission to the item so they can see it or grant them access 
afterwards.
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The ‘Chat in Teams’ button is also available on the “…” menu of a visual.  When you use it, the visual will be spot lighted when users open the link.  
Another way is to place the visual in focus mode and then press ‘Chat in Teams’.  When your colleague opens the link, they’ll see the specific visual 
you wanted them to.

New Dataset Discovery experience

Add a Power BI report to your Teams channel

Organisations may proactively roll out the Power BI app for Teams to users

There is also a new dataset discovery in Microsoft Teams experience that will be later.

This helps you discover available datasets from across the organisation directly from the Power BI app in Teams.  Power BI datasets are secured and 
governed, with permissions-based access, row level security, the ability to certify and with full support for Microsoft Information Protection (MIP).

From there, users can quickly generate a Power BI report, or choose to analyse and explore the data in Excel.

While this capability isn’t new, it’s worth a mention since adding a report as a tab to a channel helps your team keep data a priority and makes it 
easier for everyone to use the same data when decisions are made / analysis is required.

To do this:

	 •	 open the channel in a Team
	 •	 press the ‘+’ button at the top of the channel
	 •	 pick ‘Power BI’
	 •	 pick the report
	 •	 press ‘Save’
	 •	 now your report is in the channel as a tab.

Remember to give everyone permission to the report in your channel.

Many organisations need to ensure users can quickly find the data they need.  However, it’s often hard to teach users where to go to find the data 
that’s available to them.  Now, with the Power BI app for Teams, organisations may pin the app to the Teams left navigation by default for their users.

To do this, in the Teams Admin center (sic), update the policies for the organisation to pin the Power BI app for users:

	 •	 go to the Teams Admin center and add or update an app setup policy
	 •	 in Pinned apps, press ‘Add apps’
	 •	 search for ‘Power BI’ and add the app to the policy
	 •	 ‘Save’ the policy
	 •	 on the ‘Setup Policies’ page, ‘Manage Users’ for the policy, to apply it to the desired users within your organisation.
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Other points

The idea is that Teams work together in channels, chats and meetings to achieve their objectives.  There are several steps individuals and teams can 
take to take advantage of these new features:

	 •	 Add reviewing reports and dashboards to meeting agendas.  Teams can spend time in meetings reviewing key metrics.  By relating work 	
		  being done by individuals to how the work affects key metrics you encourage the team to prioritise the actions with the greatest likelihood 	
		  of the desired results.  You can use Power BI in Teams in meetings  to help the team work effectively with data and review it consistently and 	
		  constantly

	 •	 Add reports to channels as tabs.  Since individuals work and discuss in channels, adding reports to the channels helps everyone in the team 	
		  quickly find the data they need.  This is especially helpful when stakeholders change

	 •	 Leverage chat in groups and channels with ‘Chat in Teams’.  It can be hard at times to find the reports you need (don’t ask me how many 	
		  times I’ve lost things!).  However, it’s often easier to remember discussions you had about data.  By sending links in chat during meetings and 	
		  in group chat, it helps everyone access data and dig deeper to find their own insights and reports

	 •	 Data is easy to find.  The Power BI message extension lets you share links in chat with the press of a button.  The search integration lets you 	
		  mention ‘@Power BI’ in the search bar to find your recent reports and open them.
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Power BI Updates
There is a bit of a theme to this month’s updates – it’s all about visuals.  
Microsoft’s marketing department has got its hands on Power BI this month 
too, as the tool receives a brand new icon.  At last, there is a dismiss option 
to the Power BI Desktop splash screen, and probably most interestingly, 
Microsoft is introducing dynamic M query parameters in Preview. 

Be aware too that Microsoft has made a change to the version of .NET that 
is required to run Power BI Desktop.  Starting from this release, you will 
need to have .NET 4.6.2 or greater installed.  You should note that this is 
installed by default with Windows 10 and for older versions of Windows 
the Power BI Desktop installer will launch the .NET installer for you.

Here is this month’s avalanche of updates:

Reporting

	 •	 Canvas watermarks
	 •	 ‘Personalize visuals’ is now Generally Available
	 •	Data point rectangle select for Treemap

Analytics

	 •	 Export data from Q&A visua

Data Preparation

	 •	Dynamic M Query Parameters (Preview)
	 •	Automatic Table Detection from Excel files
	 •	Automatic Table Detection from JSON files

Data Connectivity

	 •	 Broader geographical support for Power Platform  
		  Dataflows connector
	 •	MariaDB now supports DirectQuery
	 •	Updated SharePoint Online List Connector
	 •	New connectors:
			   o	 Spigit
			   o	 eWay-CRM
Service

	 •	Updates to the “new look” experience and release plan

Mobile

	 •	 Power BI for HoloLens 2 (Preview)
	 •	Automatic page refresh is now supported on the Windows app
	 •	 Support for notch displays

Embedded

	 •	 Power BI Automation and APIs
	 •	 Power BI Embedded Analytics

Visualisations

	 •	 Extended admin capability features are now Generally Available
	 •	New visuals
	 •	 Zebra BI Charts (version 4.3)
	 •	 Zebra BI Tables (version 4.3)
	 •	RoadMap by ADWISE (version v1.5.0)
	 •	 ZoomCharts (version 1.6)
	 •	Bullet Chart by xViz

Template Apps

	 •	 Simplified installation
	 •	 Find template apps from the Power BI Desktop
	 •	DirectQuery support for template apps

Other

	 •	 Export data source to PBIDS in Power BI Desktop
	 •	 Icon update
	 •	Desktop splash screen dismiss.

Let’s take a look at each in turn.

Canvas watermarks

For new Power BI users, it can be difficult to know where to start, even in this highly intuitive software.  This update provides added on-canvas 
watermarks to help guide new users taking their very first steps to get data, populate the Fields pane, and drag and drop visuals.
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The latest version has also added a sample dataset, loaded directly into the Power BI Desktop.  Now, new users do not have to hunt for a dataset 
to play with the software.  By simply clicking on “try a sample dataset” from the canvas watermark new users can choose to follow along with our 
sample dataset tutorial or load the sample dataset directly to begin building visuals.
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‘Personalize visuals’ is now Generally Available

DRAG AND DROP SUPPORT

Back in May, a public Preview was provided of a new ‘Personalize visuals’ feature, that allowed users to make inline tweaks to visualisations in the 
Reading view.  For example, end users could change a measure or dimension, or even the visualisation itself.  Now it is Generally Available.

This General Availability release includes:

	 •	 Several usability improvements:

			   o	 Drag and drop support
			   o	 First-time coachmarks
			   o	 “Don’t summarize” (sic) option
			   o	 Enable / disable setting at page-level
	 •	 Embed for your organisation.

It should be noted that this feature is not on by default, so users will need turn on the feature in the ‘Report settings’ section of Power BI Service or 
Desktop.

Drag and drop fields are now supported within the same visual property and across different visual properties.  For example, this can be used to 
quickly move field in the legend to the axis of a visual:

This can also be used to quickly reorder the columns of a table or matrix:

It’s worth looking at these features in more detail.
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FIRST-TIME COACHMARKS

“DON’T SUMMARIZE” OPTION

Yes, first time I read that I didn’t know what it meant either.  Essentially, Power BI now include contextual coachmarks to help first-time users of this 
feature.  When a user first lands on a report page with a visual that may be personalised, they will see the following coachmark on the ‘Personalize 
this visual’ icon:

This update has also added the ability for end-users to change the default aggregation to ‘Don’t summarize’ (sic).  For example, in the following table 
visual you do not want to aggregate a column, but rather see the raw values for that column:

Additionally, once a user makes their first personalisation, they will see the following coachmark on the Bookmarks button, letting them know how 
they can save their personalised view:
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ENABLE / DISABLE SETTING AT PAGE-LEVEL

EMBED FOR YOUR ORGANISATION

Previously, report authors could turn this feature on or off either at a report or visual level.  Now, the ability to turn on or off this capability for all the 
visuals on a given page has been added.  You’ll find this new option in the page settings:

Many users consume Power BI reports that are embedded into their own applications, so now support has been extended for incorporating common 
embedding scenarios for your organisation.  For example, here is an example of a report that can be explored without ever leaving Microsoft Teams:
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Very shortly, a configuration option will be added for users that want to enable the ability to save the personalised view using bookmarks:

It should be noted that organisational embed support does not currently include Publish to Web (Public).

Data point rectangle select for Treemap

Export data from Q&A visual

Dynamic M Query Parameters (Preview)

This month, the data point rectangle select Preview feature has been updated to now include the Treemap visual.

This update now extends support of Export data to Q&A visuals.  You can find this option in the context menu ( . . . ) of the visual header, just like a 
standard visual:

When filtering and interacting with a Direct Query report, it’s important 
to get efficient processing and the ability to access more of the raw data.  
For those looking for better query performance optimisations without 
compromising on report interactivity, a new feature has been added: 
Dynamic M Query Parameters (Preview).  This new Microsoft Power BI 
feature allows M Query Parameters to be dynamically updated by report 
consumers based on their filter or slicer selections.  By giving authors 

control over how end-users’ filters get incorporated into the source 
query, they can optimise the performance of the query and allow end-
users to freely interact with the report, using slicers or filters.

To get started, you will need to first turn on the Preview switch: Dynamic 
M Query Parameters.
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As a prerequisite for this feature, you will need to have a valid M Query Parameter created and referred in one or more Direct Query tables.  In 
Power BI Desktop, you will need to launch Power Query from the Data tab, and select ‘New Parameters’ under the ‘Manage Parameters’ button in 
the Ribbon:

Then you will need to fill out the following information about the Parameter:
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Once you have created the parameters, you can now reference them in M query.  To modify the M Query, you will need to open the Advanced editor 
while you have the Query (that you want to modify) selected:

Now that you have created the parameters and referenced them in the M 
Query, next, you will need to create a table with a column that provides 
the possible values available for that parameter.  This will allow it such 
that the parameters are dynamically set based on filter selection.  In this 

example, we want our StartTime Parameter and EndTime Parameter 
to be dynamic.  Since these parameters are requiring a Date / Time 
parameter, we want to generate date inputs that can be used to set the 
date for the parameter.  To start, we will create a new table:

Then, you will need to reference the parameters in the M Query:

let
   selectedRepoNames = if Type.Is(Value.Type(RepoNameParameter), List.Type) then 
      Text.Combine({"'", Text.Combine(RepoNameParameter, "','") , "'"})
   else
      Text.Combine({"'" , RepoNameParameter , "'"}),

   KustoParametersDeclareQuery = Text.Combine({"declare query_parameters(", 
                                 		  "startTime:datetime = datetime(", 
DateTime.ToText(StartTimeParameter, "yyyy-MM-dd hh:mm"), "), " , 
                                 "endTimep:datetime = datetime(", 
DateTime.ToText(EndTimeParameter, "yyyy-MM-dd hh:mm:ss"), "), ", 
                                 "repoNames: dynamic = dynamic([", selectedRepoNames, 
"]));" }),

   ActualQueryWithKustoParameters = "GithubEvent 
         		 | extend RepoName = tostring(Repo.name)
         		 | where RepoName  in(repoNames)| make-series count() on  CreatedAt from startTime 
to endTimep step 12h by RepoName
         		 | evaluate python(typeof(*), 'result = df')
         		 | mv-expand count_ to typeof(long), CreatedAt to typeof(datetime)",

      finalQuery = Text.Combine({KustoParametersDeclareQuery, 
ActualQueryWithKustoParameters}),

   Source = AzureDataExplorer.Contents("demo11.westus", "GitHub", finalQuery, [MaxRows=null, 
MaxSize=null, NoTruncate=null, AdditionalSetStatements=null])
in
    Source
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Here is the first table created for the values for StartTime Parameter:

Here’s the second table created for the values for EndTime Parameter:

Now that the tables with the Date field have be created, we can bind 
each field to a parameter. Binding the field to a parameter means that 
as the selected value for the field changes, this value will get passed to 

the parameter and update the query where the parameter is referenced.  
Therefore, to bind field, go to the Modeling tab, select the newly created 
field, and go to the Advanced Properties:

StartDateTable = CALENDAR (DATE(2016,1,1), DATE(2016,12,31))

EndDateTable = CALENDAR (DATE(2016,1,1), DATE(2016,12,31))
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Select the dropdown under bind to parameter and set the Parameter which you want to bind the field to:

This example parameter is for a single-select value (setting the parameter to a single value), so we will want to keep Multi-select set to No, which is 
the default:
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If your use cases require multi-selection (passing multi-values to a single 
parameter), you will toggle this above switch to Yes, and you will need 
to ensure that your M Query is setup properly to accept multiple values 
in the M Query.

Finally, you can now reference this field in a slicer or as a filter.  Note 
that if the mapped column is set to No for Multi-select, you will need to 
use either a single select mode in the slicer or require single select in the 
Filter card.

Automatic Table Detection from Excel files

Automatic Table Detection from JSON files

Broader geographical support for Power Platform Dataflows connector

MariaDB now supports DirectQuery

Updated SharePoint Online List Connector

When using the Excel connector, this new feature will automatically 
identify sections of each Excel spreadsheet to extract into a table and 
show them under a ‘Suggested Tables’ group in the Navigator. Previously, 
unless data was formatted as Tables or Named Ranges in Excel, users 

had to scrape the relevant rows / columns with specific transforms (skip 
rows, remove columns, etc.) from worksheet objects (e.g. Sheet1 in the 
example below).  To use this feature, you will need to enable it in the 
Settings dialog.

When using the JSON connector, the new feature will automatically 
flatten the JSON into table.  Previously, users had to flatten records / lists 
manually.  This new feature also adds support for JSON lines (or newline-

delimited JSON, where each line in the file is a JSON string).  To use this 
feature, you will again need to enable it in the Settings dialog.

There is now a broader geographical support for the Power Platform Dataflows connector.  The Power Platform Dataflows connector now supports 
Germany, UAE, Switzerland and South Africa endpoints too.

The MariaDB team has updated their connector that was introduced last month to now support Direct Query, empowering users to run more 
intensive reports against their MariaDB server.

There is now a new version of the SharePoint Online connector, which should provide improved performance and greater usability.
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With this connector, there will now be two different views available for the same data:

	 1.	 All
	 2.	 Default.

The default view is what you will see when looking at the list online in whichever view you have set as ‘Default’ in your settings.  If you edit this view 
to add or remove either user created or system defined columns, or by creating a new view and setting it as default, this will propagate through the 
connector.

The ‘All’ view includes all user created and system defined columns.

You can opt in to the new connector by selecting “2.0 (Beta)” under Implementation when connecting to SharePoint Online List.
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New connectors

SPIGIT

EWAY-CRM

Updates to the “new look” experience and release plan

Spigit innovation management software enables you to analyse an employee’s, partner’s or customer’s ideas, manage them, and bring them to 
market with reduced effort.  The connection type for this connector is Import and you will find it in the Other category.

eWay-CRM is a CRM system embedded into Microsoft Outlook.  It 
helps companies all around the world with their CRM agenda, project 
management and business opportunities.  A single workspace allows you 
to collect, organise and share all of the information important to your 

business using software you already use.  It allows you to make e-mails, 
calendar events, notes and documents immediately available to your 
team.  The connection type for this connector is Import and you will find 
it in the ‘Online Services’ category.

The ‘new look’ of the Power BI Service is evolving yet again.  Microsoft 
has made navigation updates to provide more space to work with 
your content, provided options for report authors to configure their 
page navigation, updated the action bar for quicker access to common 
actions, and more.

The ‘new look’ is close to being the default experience for all users by the 
end of October (i.e. before you have read this!).
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Power BI for HoloLens 2 (Preview)

September saw the Power BI app for HoloLens 2, bringing insights into 
the real world through augmented reality.  This makes it easy to view and 
interact with reports and dashboards on top of the real-world environment.  

Users can get report pages and dashboards into mixed reality, and once 
they do, visuals exist there every time they open the app, updated in real 
time, and persisting until they choose to remove them.

Automatic page refresh is now supported on the Windows app

Support for notch displays

Power BI Automation and APIs

Report pages using auto page refresh will now also be refreshed in the 
Windows app.  With auto page refresh, presentations and slideshows 

will update in real-time, ensuring that you will always be displaying the 
latest business data and insights.

iPhone and iPads now support notch displays, giving you more screen space for reports and dashboards.

The Viewer role gives a read-only experience to users.  This role should be assigned to users who need to view content within workspaces without the 
ability to modify it.  Starting now, the Power BI APIs support this Viewer role.  You can now add a user to a workspace with viewer role permissions.  
That’s very useful.
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Power BI Embedded Analytics

Extended admin capability features are now Generally Available

New visuals

Zebra BI Charts (version 4.3)

PERSONAL BOOKMARKS NOW AVAILABLE FOR EMBEDDING FOR YOUR ORGANISATION 

PERSONALIZE VISUAL ON EMBEDDED SCENARIOS 

REPORT ACTION BAR AND PERSISTENT FILTERS ARE COMING TO EMBED FOR YOUR ORGANISATION 

By the time you read this, the Power BI ‘new look’ will be reflected for Power BI embedded analytics scenarios.  There will be several new features.

The new administrator capabilities are now Generally Available.  Power 
BI administrators can import and manage AppSource visuals directly 
to the organisational visuals page in the admin portal.  Any AppSource 
visual imported to the organisational store will retain Power BI 
certification, and will automatically be updated when a new version is 

available.  Additionally, Power BI administrators can pick any visual from 
the organisational store to show up automatically in the Visualization 
pane of the entire signed-on organisation members, in Power BI Desktop 
or the Service.

We are not going through all of these, but new visuals this month include:

	 •	 Clustered Stacked Bar Chart by DEFTeam Solutions Pvt Ltd
	 •	 Hierarchical Bar Chart by Excelnaccess.com
	 •	 HTML Content by Daniel Marsh-Patrick
	 •	 process.science Process Mining by process.science GmbH & Co. KG
	 •	 Overview by CloudScope
	 •	 Image by CloudScope
	 •	 Timeline by CloudScope
	 •	 User List by CloudScope.

Since reporting space is always very precious, this visual has developed a new method to find a way to save it.  The Zebra BI team developed a new 
algorithm to optimise the layout of charts in small multiples – all within one single visual.

Personal bookmarks allow report consumers to create their own set of bookmarks for each report by capturing various states of a report page.  Now, 
report consumers can use the same personal bookmarks they are using on Power BI Service when consuming embedded analytics.

‘Personalize visual’ allows you to explore and personalise visuals all within the consumption view of a report.  When you turn on ‘Personalize visual’ 
for a report, the option to personalise a visual will also be available when consuming embedded analytics.

When embedding for your organisation, consumers will now be able to use the Power BI report action bar.  In addition, persistent filters which allow 
your users to retain their report state will also be available as part of it.  The same state will be shared both for consuming the report on embedded 
analytics and on Power BI Service.
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In older versions of Zebra BI, a big chart could already span over two 
smaller charts.  Now, however, it can span over multiple charts.  The 
spanning of bigger charts can now happen in multiple columns, while 
before it could only happen once.  The exact allocation of space has also 
been improved, resulting in an extremely optimised display of small 
multiples where practically no space is wasted.

This feature is especially useful in situations where you have big 
differences in values between data categories.  The new ‘Automatic’ 
layout works with all Zebra BI charts and all their settings.

You can change the chart type and set the display of charts to Top N with 
all other charts automatically aggregated to “Others” category.

Zebra BI Tables (version 4.3)

RoadMap by ADWISE (version v1.5.0)

There are many new functionalities in Zebra BI Tables visuals.  New features include:

	 •	 You may now display any of your additional measures as charts
	 •	 you can select the type of your measure to ensure the most appropriate display or visualization of each column:
	 •	 a brand new concept of Scaled groups has been introduced in Zebra BI Tables.  Since additional measures in tables are often showing KPIs 	
		  that are unrelated to other KPIs in the same visual, you can decide how they should be scaled by adding them to separate Scaled groups.  	
		  You can set up to six scaled groups in this way.  The picture below shows a P&L statement with margins, where a ‘% of Revenue’ measure is 	
		  visualized as a pin chart and also its change / variance from PY is calculated in percentage points and visualised (the red / green column on 	
		  the far right):

You can plan, roadmap, and time schedule phases and milestones using ADWISE RoadMap.  This visual can help you present your project, product 
or campaign plans, or plans of whatever else that can be time-scheduled, in this updated version.
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A lot of improvements and functionalities have been added to this latest guise:

	 •	 get started quickly with only three fields needed (axis y, start and end date)
	 •	 ToolTips functionality added to better describe all the items on the roadmap
	 •	 no problem either roadmapping projects or campaigns.  Now, you can use your own names for field labels (shown in ToolTips)
	 •	 group text is now fully configurable, e.g. text wrapping, alignment and colour
	 •	 new milestones options: size, new shape “+”, text on / off and hiding text option (when milestones are close together)
	 •	 more colouring options across roadmap items: colour groups / bars / milestones by group, by category, by range and default
	 •	 improved behaviour when filtering and adding new data (e.g. categories retain colours).

ZoomCharts (version 1.6)

The latest release of ZoomCharts visuals has several new updates.  

From this version onwards, ZoomCharts has switched to the matrix 
view for data aggregation and processing.  It means that Drill Down Pie 
PRO, Drill Down Donut PRO, Drill Down Combo PRO, Drill Down Combo 
Bar PRO all now fully support measures, drill-through and Report Page 

ToolTip from any drilldown level, with the rest of the visuals catching up 
in the next release.

The Drill Down Graph PRO visual has also had a major upgrade.  It now 
offers full control over the graph exploration experience, extended 
customisation options and multiple layout options.

There is more:

	 •	 Dynamic, radial and hierarchical layouts: these enable you to use a graph to visualise not only for relationship and outlier detection, but also 	
		  map hierarchical relationships such as organisational structure

	 •	 Expansion levels, direction and radius: you can choose whether to display all graph nodes at once or else let users explore relationships 	
	 	 among nodes by revealing the child nodes on click.  You can also control direction of node expansion, and how many ‘child’ levels to reveal 	
	 	 on click

	 •	 Auras: group nodes in colour-coded clusters to better visualise relationships among them
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	 •	 Upgraded toolbar: search box, save state, reset button, dark mode and other new features 

	 •	 New customisation options: separately customisable source and target nodes, link grouping in categories, outline formatting, hyperlink 	
	 	 support in ToolTip and more.

Bullet Chart by xViz

xViz has released a new PBI Certified version (1.1.6) of the Bullet Chart 
which supports several new use cases such as single KPI as well as 
the International Business Communication Standards Institute (IBCS) 

improvements to the bullet chart.  Improvements include highlighting 
the variances between actual and target, with the help of variance bar 
and normalising target values to facilitate visual evaluation.
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Seven (7) pre-built templates have been added, where users may 
select the desired templates and quickly get started without spending 
time navigating through the property sheet.  These include improved 
user interfaces, with data label and comparison band enhancements 

for better positioning and formatting capabilities, for the newly added 
Single KPI use case.  Other notable features include Target section 
enhancements, sorting based upon variances and an Analytics section.

Simplified installation

Find template apps from the Power BI Desktop

There is a new simplified installation for template applications, as new 
users of Power BI might find it difficult to configure a newly installed 
template app.  From last month onwards, apps that support the simplified 

installation feature can be installed with pre-populated authentication 
and privacy settings.

As the template apps gallery continues to grow, more ways keep being 
added for users to find their required templates from Power BI Desktop.  
Many of Microsoft’s partners who are extending connectivity to Power 

BI Desktop publish template apps offering pre-built reports and dataset 
to use as well.

To find template apps from Power BI Desktop, head to ‘Get Data’ and observe the new link to discover Template Apps.  Once you finish installing and 
connecting the data to the template, you may build your own report by connecting to the dataset, just like any other dataset in Power BI.

The configuration stage has been enhanced too.  Microsoft has added a 
link to each app’s documentation so it is easy to learn how to configure 
the app.  There is also example text to make sure it is clear which 

parameters require user attention.  Support has been extended too for 
list parameters, allowing builders and installer to use list parameters.
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DirectQuery support for template apps

Export data source to PBIDS in Power BI Desktop

Template app partners can now build apps that connect to DirectQuery 
(DQ) data sources.  When you install a template app that uses a 
DirectQuery data source, you will be prompted to connect your data 
before navigating to the app to make sure your data is available when 
you get there.

Being able to build template apps using supported DQ data sources opens 
up a host of possibilities for offering BIG data analytics from sources such 
as Azure Data Explorer, Dynamics 365, SQL, and many others.

This time last year, Microsoft released a new file format, PBIDS, that 
allowed users to start from a file that already has a data source connection.  
This file type essentially streamlined the ‘Get data’ experience, making 
it quicker for users to start building reports.  Previously, you had to 
manually create these files in a notepad editor or using the file generator 

tool provided by Power BI Tips.  Now in this release, you can now auto-
generate these connection files from within Power BI Desktop.

You can find this setting by going to File -> Options and settings -> Data 
source settings:

Then you select the data source that you want to export as a PBIDS:

When you select ‘Export PBIDS’, Power BI will automatically generate the PBIDS file which you can rename and save in your directory and share with 
others.  Optionally, if you open the file in a text editor, you can modify the file further, including specifying the mode of connection in the file itself.
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Icon update

Desktop splash screen dismiss

Across the Power Platform Microsoft has now updated their product icons to the new ‘Fluent design’ system.  The jury’s out on this one!

At long last!!  Microsoft has FINALLY added the long-awaited dismiss ‘X’ to the Desktop splash screen.  Now, if you accidently launch Power BI 
Desktop, you can close the application from the splash screen.  Yay!

That’s it for this month – more next month, we’re sure!
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Improved MDX Query Performance in Power BI
Aside from the usual monthly updates to Power BI, with the recent update 
of the Analysis Services Tabular engine in Power BI, Multidimensional 
Expressions (MDX) clients, such as Microsoft Excel, are now able to enjoy 
improved query performance.  This MDX performance improvement 
alleviates some of the optimisation burden for measures used in a 
PivotTable, where the MDX language is prevalent. 

For example, Excel users connecting to a Power BI dataset by using the 
Analyze in Excel feature, the XMLA endpoint, or the newly announced 
Power BI Datasets within Excel feature, will now notice significantly 
better PivotTable performance.

The MDX query performance improvement is the result of a Formula 
Engine (FE) optimisation, aimed at reducing the number of Storage 

Engine (SE) queries per MDX query, similar to DAX optimisations, known 
as DAX Fusion.  With MDX Fusion, the most common MDX query patterns 
can now trigger far fewer SE queries, where previously numerous such 
SE queries were necessary for different granularities.  Fewer SE queries 
mean fewer expensive scans over large datasets, which ultimately 
results in sizeable performance gains, especially when connecting to a 
Tabular model or Power BI dataset in Direct Query mode.  Whilst it is 
a new feature, please note that MDX Fusion is not available with SQL 
Server Analysis Services 2019 or earlier.

As an illustration, consider a simplified but nonetheless typical MDX 
query that Excel might generate for a PivotTable against a Power BI 
dataset:

The following screenshot shows the results based on AdventureWorks 
sample data, listing the average unit price and total sales amount for 
each product subcategory and category.  The NON EMPTY CrossJoin 
causes the result to include only those rows where data is available 
for the specified measures and the WHERE clause limits the results 

to the year 2014.  The most interesting part is that Excel references 
all members of a hierarchy and usually also includes the special “ALL” 
member in order to retrieve all levels of granularity (subtotals and totals) 
in a single MDX query.

You can see multiple levels of detail in the PivotTable screenshot above 
for the two measures.  At the lowest granularity, each subcategory 
has its own Avg Unit Price and Total Sales Amount, and each category 
summarises its subcategories.  Then, at an even higher level, the 
PivotTable also includes the grand total.  And yet Excel only sent a single 

MDX query.  Accordingly, the Analysis Services engine in Power BI must 
compute the cell values for the two measures based on three different 
granularities on the axes.  This might cause the Formula Engine to trigger 
six or more queries to the Storage Engine, as listed in the following table:

SELECT
   	 {[Measures].[Avg Unit Price],[Measures].[Total Sales Amount]} ON COLUMNS,
   	 NON EMPTY Hierarchize(DrilldownMember(CrossJoin(

{[DimProductCategory].[EnglishProductCategoryName].[All],[DimProductCategory [EnglishProdu
ctCategoryName].[EnglishProductCategoryName].AllMembers}, 
{([DimProductSubcategory] [EnglishProductSubcategoryName].[All])}), 
[DimProductCategory].[EnglishProductCategoryName].[EnglishProductCategoryName].AllMembers,
[DimProductSubcategory].[EnglishProductSubcategoryName]

    		 )) ON ROWS 
FROM [Model] WHERE ([DimDate].[CalendarYear].&[2014])
PROPERTIES VALUE
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Attribute Definition

Subcategory totals

Average of Unit Price from 
FactInternetSales, grouped by 
Product Category and Product 
Subcategory for 2014

Total of Sales Amount from FactInternetSales, 
grouped by Product Category and Product 
Subcategory for 2014

Category totals
Average of Unit Price from 
FactInternetSales, grouped by 
Product Category for 2014

Total of Sales Amount from FactInternetSales, 
grouped by Product Category for 2014

Grand total
Total Average of Unit Price 
from FactInternetSales for 
2014

Total of Sales Amount from FactInternetSales 
for 2014

Looking again at the PivotTable image (above), it is clear that the 
Formula Engine could calculate the category totals and grand total for 
each measure based upon the subcategory totals.  In other words, the 
two SE queries for the category totals and the two SE queries for the 
grand totals are not necessary.  This alone is a significant optimisation.

Perhaps less obvious is the fact that both measures, Avg Unit Price and 
Total Sales Amount, access columns from the FactInternetSales table 
and use the same where and group by clauses, making it possible to 
combine even the remaining subtotals queries in a straightforward way.  
Hence, a single combined (or fused) SE query can replace the previous six 

SE queries for a nice boost in MDX query performance: Sub-Average of 
Unit Price, Sub-Total of Sales Amount from FactInternetSales, grouped 
by Product Category and Product Subcategory for 2014.

A comparison of the following two query traces helps to illustrate the 
impact of MDX Fusion.  The first is a trace from SQL Server Analysis 
Services 2019, which shows the six separate SE queries, plus an additional 
SE query for the date dimension attributes.  The TextData column reveals 
enough detail to correlate the SE queries with the pseudo-expressions 
from the previous table.

MDX Fusion is an important Analysis Services Tabular capability that can 
help improve the user experience in Excel and other client applications 
that use the MDX query language against tabular models and Power BI 
datasets.  Check it out by deploying your datasets in Power BI and then 

connecting with Excel by using Analyze in Excel, the newly announced 
Power BI Datasets within Excel feature, or even connect to your datasets 
on Power BI Premium through the XMLA endpoint.

The second trace shows the processing with exactly the same Excel MDX 
query against a comparable dataset in Power BI.  As you can see, the 
number of SE queries dropped from seven to two.  The MDX query not 
only returns faster, MDX Fusion also helps to reduce the workload on the 

data source in DirectQuery mode as Power BI sends significantly fewer 
DirectQuery queries.  Of course, MDX Fusion is also available in import 
(Vertipaq) mode.

Here’s your Starter for 10.  Please write a 10,000-word essay on the subject of the FALSE function.  
I think that’s easy.  Actually, it’s FALSE!  Quod Erat Demonstrandum.

The FALSE function returns the logical value FALSE and employs the following syntax to operate:

FALSE()

The A to Z of Excel Functions: FALSE
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That’s right, there can be no argument it takes no argument (oh I am having fun with this function…).

It should be further noted that: 

	 •	 you may also type the word FALSE directly onto the worksheet or into the formula, and Microsoft Excel interprets it as the logical value FALSE
	 •	 the FALSE function is provided primarily for compatibility with other spreadsheet programs
	 •	 I am dragging this article out quite a bit.

Please see the example below: 

The cumulative distribution function is given by

Where I is the regularised incomplete beta function:

In other words, use the F.DIST function in Excel when you need to and try not to ask too many questions.

The F-distribution has two important properties:

	 1.	 It’s defined only for positive values.
	 2.	 It’s not symmetrical about its mean; instead, it’s positively skewed.

The A to Z of Excel Functions: FDIST
Named after Sir Ronald Aylmer Fisher, a British statistician, geneticist and 
mega-genius, the F-distribution is defined as a continuous distribution 
obtained from the ratio of two chi-square distributions and used in 
particular to test the equality of the variances of two normally distributed 
variances a continuous probability distribution, which means that it is 
defined for an infinite number of different values.  This analysis of variance 
is often referred to as “ANOVA”, which I thought was a cheap car.

I’m glad we have cleared that up then, eh?  

To be “slightly” clearer, the F-distribution can be used for several types 
of applications, including testing hypotheses about the equality of 

two population variances and testing the validity of what is known as 
a multiple regression equation, i.e. a formulaic attempt to model the 
relationship between two or more explanatory variables and a response 
variable by fitting a linear equation to observed data.  

The F-distribution shares one important property with the Student’s 
t-distribution: probabilities are determined by a concept known 
as degrees of freedom.  Unlike the Student’s t-distribution, the 
F-distribution is characterized by two different types of degrees of 
freedom: numerator and denominator degrees of freedom.

The formula for the probability density function is given by

A distribution is positively skewed if the mean is greater than the median 
(the mean is the average value of a distribution, and the median is the 
midpoint; half of the values in the distribution are below the median and 
half are above).  This function returns the F probability distribution.   You 
can use this function to determine whether two data sets have different 
degrees of diversity.  

A good example of a positively skewed distribution is household incomes.  
Suppose that half of the households in a country have incomes below 

$50,000 and half have incomes above $50,000; this indicates that the 
median household income is $50,000.  Among households with incomes 
below $50,000, the smallest possible value is $0.  Among households with 
incomes above $50,000, there may be incomes of several million dollars 
per year.  This imbalance between incomes below the median and above 
the median causes the mean to be substantially higher than the median.  
Suppose for example that the mean income in this case is $120,000.  This 
shows that the distribution of household incomes is positively skewed.
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This image (above) shows a graph of the F-distribution for different 
combinations of numerator and denominator degrees of freedom.  
In each case, numerator degrees of freedom are listed first, and 
denominator degrees of freedom are listed second.  The level of 
significance in each case is 0.05.

A level of significance is used to test a hypothesis.  An hypothesis test 
begins with a null hypothesis; this is a statement that’s assumed to be 
true unless there is strong contrary evidence.  There is also an alternative 
hypothesis; this is a statement that is accepted in place of the null 
hypothesis if there’s sufficient evidence to reject the null hypothesis.

The level of significance, designated alpha, refers to the probability of 
incorrectly rejecting the null hypothesis when it is actually true.  This is 
known as a Type I error.  By contrast, a Type II error occurs when you fail 
to reject the null hypothesis when it’s actually false.  Therefore, with a 
level of significance of 0.05, there is a 5 percent chance of committing a 
Type I error.

The figure shows that the distribution isn’t defined for negative values 
(as you can see, no negative values appear along the horizontal axis).  
Additionally, as the number of degrees of freedom increases, the shape 
of the distribution shifts to the right.  The distribution has a long right tail 
(more formally, it’s skewed to the right, or positively skewed).

FDIST returns the (right-tailed) F probability distribution (degree of 
diversity) for two data sets.  You can use this function to determine 
whether two data sets have different degrees of diversity.

Important: This function has been replaced by newer ones which may 
provide improved accuracy and whose names better reflect their usage.  
Although this function is still available for backward compatibility, you 
should consider using this newer function from now on, because the 
older variant may not be available in future versions of Excel, according to 
Microsoft.  However, this is NOT the equivalent of F.DIST.  Interestingly, 
it is F.DIST.RT which supersedes FDIST.

The FDIST function employs the following syntax to operate:

FDIST(x,deg_freedom1,deg_freedom2).

The reason for his is due Microsoft’s apparent insistence on ensuring all 
functions ending in .DIST (e.g. NORM.DIST, NORM.S.DIST, T.DIST) return 
the left portion of a distribution, not the right.  However, you would 
have to work very hard to invent a situation in which you would expect 
the F-ratio’s numerator to be smaller than its denominator.  It’s likely if 
this did occur, it would probably be attributable to misreferencing the 
data.  The F-test is a right-tailed test, unlike the z-test or t-test, where the 
directionality of the difference is important.

The FDIST function has the following arguments:

	 •	x: this is required and represents the value at which to evaluate 	
		  the function
	 •	deg_freedom1: this is also required and denotes the numerator 	
		  degrees of freedom
	 •	deg_freedom2: this is again required and represents the 		
		  denominator degrees of freedom.

It should be further noted that: 

	 •	 if any argument is non-numeric, FDIST returns the #VALUE! error 	
		  value
	 •	 if x < 0, FDIST returns the #NUM! error value
	 •	 if deg_freedom1 or deg_freedom2 is not an integer, it is truncated
	 •	 If either deg_freedom1 or deg_freedom2 is strictly less than 1 		
		  or either deg_freedom1 or deg_freedom2 is greater than or equal 	
		  to 10^10, FDIST returns the #NUM! error value
	 •	FDIST is calculated as FDIST=P( F>x ), where F is a random variable 	
		  that has an F distribution with deg_freedom1 and deg_freedom2 	
		  degrees of freedom.
Please see another example below: 
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The A to Z of Excel Functions: FIELDVALUE
There’s some exciting news for those using Excel 2016 on an Office 365 
basis (i.e. not the “perpetual licence”).  You might not have this initially, 
but don’t fret.  According to Microsoft, this feature is being made available 
to users on a “gradual basis” over several days or weeks. I t will first be 
available to Office Insider participants and later to Office 365 subscribers.  
If you are an Office 365 subscriber and you want it is as soon as it becomes 
available, do ensure you have the latest version of Office at all times (keep 
those updates updated!).

So, what’s the big deal?

For a start, you can now get stock and geographic data in Excel.  All you 
have to do is type text into a cell and convert it into the ‘Stocks’ data type 
or the ‘Geography’ data type.  These two data types are new, and they are 
considered linked data types because they have a connection to an online 
data source.  That connection allows you to bring back rich information 
that you can work with and refresh.  You know – the things you have 
wanted to do for years!

Here’s a peek at the two new data types:

Data Type 1: Stocks

Data Type 2: Geography

Step 1: Type Some Text

In this graphic, the cells with company names in column A contain the ‘Stocks’ data type.  You may tell this because they have this icon      .  The 
‘Stocks’ data type is connected to an online source that contains more information.  Columns B and C are extracting that information.  Specifically, 
the values for price and change in price are getting extracted from the ‘Stocks’ data type in column A.

In this example, column A contains cells that have the ‘Geography’ data type.  This time, the        icon indicates this.  This data type is connected to 
an online source that contains more information.  Columns B and C are again extracting that information.  Specifically, the values for population and 
gasoline price are getting extracted from the ‘Geography’ data type in column A.

We are sure you can see how these data types might be useful.  So how do you set it up?  Assuming you have had your version of Excel 2016 updated, 
it’s as easy as, er, 1, 2, 3, 4, 5, 6…

That’s right: just type some text in cells.  In this example, we wanted data based on geography, so we typed country names.  However, you could also 
have typed province names, territories, states, cities, etc.  If you want stock information, similarly type company names, fund names, ticker symbols, 
and so on.
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Step 2: Create a Table

Step 3: Select Some Cells

Step 4: Pick a Data Type

Step 5: Icons Appear

Although it's not required, it is recommended you create an Excel Table.  This is so ranges may be extended readily and easily later, should you wish.  
Select any cell in your data and go to Insert > Table or use the keyboard shortcut CTRL + T.  This will make extracting online information easier later on.

Next, select the cells that you want to convert to a data type.

If Excel finds a match between the text in the cells and the online sources, it will convert your text to either the ‘Stocks’ data type or ‘Geography’ data 
type.  You will know immediately if they have been converted since they will have the        icon for stocks and the        icon for geography.

On the ‘Data’ tab, click either ‘Stocks’ or ‘Geography’.
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Step 6: Add a Column

Click the ‘Add Column’ button       , and then click a field name to extract 
more information, such as ‘Population’.

If you see the       symbol instead of an icon, then Excel is having difficulty 
matching your text with data in Microsoft’s online sources.  Go back and 
review your data.  Correct any spelling mistakes and when you press 

ENTER, Excel will do its best to find matching information.  If this does 
not work, click      and a ‘Selector’ pane will appear.  Search for data  
using a keyword or two, choose the data you want and then click ‘Select’.   
That’s it!

How to Write Formulae that Reference Data Types

You can use formulae that reference linked data types.  This allows you 
to retrieve and expose more information about a specific linked data 
type.  For example, consider the linked data type, Stocks, used in cells 

A2:A11 below.  In columns B and C, there are formulae that extract more 
information from the ‘Stocks’ data type in column A, viz.

In this example, cell B2 contains the formula =A2.Price and cell C2 
contains the formula =A2.Change.  When the records are in a Table, 
you can use the column names in the formula instead.  In this case, cell 

B2 would contain the formula =[@Company].Price and cell C2 would 
contain =[@Company].Change.  The additional benefit is that these 
formulae would automatically copy down too.

Some tips for when you start playing with these two new data types: 

	 •	 as soon as you type the dot operator (.) after a cell or column reference, Excel will present you with a formula AutoComplete list of fields 	
		  that you can reference for that data type.  Select the field you want from the list or type it if you know it
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	 •	 data type field references are not case sensitive, so you can enter =A2.Price, or =A2.price
	 •	 if you select a field that has spaces in the name, Excel will automatically add brackets ([ ]) around the field name, e.g. =A2.[52 Week High]
	 •	 the FIELDVALUE function can also be used, but it is recommended only for creating conditional calculations based on linked data types.

This last point is a nice lead into the other new item…

The FIELDVALUE Function

Examples

Technical details

You can use the FIELDVALUE function to retrieve field data from linked 
data types like the ‘Stocks’ or ‘Geography’ data types.  There are easier 
methods for writing formulae that reference data types (see above), so 
the FIELDVALUE function should be used mainly for creating conditional 
calculations based on linked data types.

Similar to the new data types, this brand-new function is being made 
available to customers on a gradual basis over several days or weeks.  It 
will first be available to Office Insider participants and later to Office 365 
subscribers.  If you are an Office 365 subscriber, make sure you have the 
latest version of Office or you may not get the update when it’s your turn.

In the following basic example, the formula, =FIELDVALUE(A2,"Price") extracts the Price field from the ‘Stock’ data type for the “internationally-
renowned” JM Smucker Co.

The next example is a more typical example for the FIELDVALUE function.  Here, we’ve used the IFERROR function to check for errors.  If there isn't 
a company name in cell A2, the FIELDVALUE formula returns an error, and in that case, displays nothing ("").  However, if there is a company name, 
then we want the formula to retrieve the Price from the data type in A2 with =IFERROR(FIELDVALUE($A2,B$1),"").

Note that the FIELDVALUE function allows you to reference worksheet 
cells for the field_name argument, so the above formula references cell 
B1 for Price instead of manually entering "Price" in the formula. 

If you try to retrieve data from a non-existent data type field, the 
FIELDVALUE function will return the new #FIELD! error.  For instance, 
you might have entered "Prices", when the actual data type field is 

named "Price".  Double-check your formula to make sure you've used a 
valid field name.  If you want to display a list of field names for a record, 
select the cell for the record and press CTRL + SHIFT + F2.

More Excel Functions next month…

Syntax 

=FIELDVALUE(value, field_name) 

The FIELDVALUE function syntax has the following arguments:

	 •	 value: this is the cell address, table column or named range that contains a linked data type
	 •	 field_name: this is the name or names of the fields you would like to extract from the linked data type.

Description 

The FIELDVALUE function returns all matching fields(s) from the linked data type specified in the value argument.  This function belongs to the 
Lookup & Reference family of functions.
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Beat the Boredom Suggested Solution
This month’s challenge was about Black Friday.  A quick recap:

	 •	 For any given Friday – like Black Friday 27th, when can I expect it to be Friday the 27th again?
	 •	 For any given year, which date is the Black Friday so one can get specials?
	 •	 And as a bonus question, when will we have another Black Friday sale on the 27th of November?

Let’s work it all out.

Calculating the next Friday 27th

Calculating the date of Black Friday

Calculating the date of the next identical Black Friday

As mentioned earlier about Friday 27th, the longest period that can 
occur without a Friday the 27th is 14 months.  Breaking that down:

	 •	 Generate the next 14 months combination with that day
	 •	 Check if they lie on a Friday
	 •	 Return the result.

Firstly, let’s check the next 14 months to see if that particular number 
day of the month lies on a Friday and return with that first result.  This 
can be done in a line, in a single formula, using an array calculation to 
get all 14 months.  We will use the WEEKDAY function.  WEEKDAY takes 
a date and then returns a numeric value representing the day of the 
week, Friday being the sixth day of the week (where Sunday is the first 
by default).  We can combine this fact with the MATCH function to find 
which month it is the next in the series.

A trick to generate an array of numbers without typing them, e.g. 
{1,2,3,4,5…} is to use the ROW function.  By using the ROW function, this 
returns an array with the numbers of the rows in question.  To generate 
{1..14} we may use the following:

=ROW(A1:A14)

To generate the dates, you may use the DATE function to generate the 
serial dates (dates in Excel formats), it takes three parameters, the year, 
month and day.

For the year, simply either enter a year number or find the year of any 
given date like today, TODAY(), by using the formula:

=YEAR(TODAY())

The month and day may be generated similarly.

To find the next month, combining MATCH with ROW, let’s assume that 
we are seeking from TODAY():

NextCorrespondingMonth = MATCH(TRUE, 
WEEKDAY(DATE(YEAR(TODAY()), ROW($A$1:$A$15) + 

MONTH(TODAY()) + IF(DAY(TODAY()) < 27, -1, 0), 27)) = 6, 0)

The IF statement, checking if today is less than the 27th is to ensure that 
it checks the rest of the existing month as well, hence the subtraction of 
one (1).  Then, by adding the number of months to the current date, the 
next occurrence will be calculated.

NextBlackFriday = DATE(YEAR(TODAY), MONTH(TODAY) + 
NextCorrespondingMonth, 27 )

However, as the MATCH is operating on an array, assuming you do not 
have access to dynamic arrays, CTRL + SHIFT + ENTER must be used in 
order for Excel to recognise the array function and calculate the result 
correctly.

Thanksgiving in the USA is defined to be the fourth Thursday in the month 
of November.  Therefore, given the year, look at the fourth Thursday and 
check what the date is + 1 for Black Friday.  How is this done in Excel?

What can be done is by checking through all the combinations of dates 
for that period, finding which one would be a Friday.  This is done on the 
DAY instead of the MONTH.

To calculate Thanksgiving, the initial Thursday can start with a number 

between 1 to 7.  Add 22 days to get the Black Friday (three weeks to give 
the fourth Thursday and then add one extra day).  Therefore, for 2020, 
Black Friday may be calculated as

=DATE(2020, 11, MATCH(TRUE, WEEKDAY(DATE(Input_BFYear, 11, 
ROW($A$1:$A$7)+22)) = 6, 0) + 22)

Remember, this is an array calculation as well so again, we must use 
CTRL + SHIFT + ENTER!

The Gregorian Calendar identically loops on a 400 year cycle.  Why is 
this the case?  This is because despite the fact that every year shifts each 
calendar day by one, each leap year shifts each calendar day by TWO 
days.  But leap years don’t always occur every four years.  When it is a 
year divisible by 100, such as 1900, unless it is divisible by 400 like 2000, 
these years aren’t leap years.

Though a collision of an identical Black Friday is more likely to occur 
within a 28 year period when the full combination of common and leaps 
years can occur.  Just in case our dataset includes a centennial we should 
include another 28 years into our set to counteract this phenomenon. 

Hence, the next identical Black Friday can be calculated as:

=DATE(YEAR(TODAY()) + MATCH(TRUE, WEEKDAY(DATE(YEAR(TODAY()) + ROW($A$1:$A56), 11, 27)) = 6, 0), 11, 27)

Until next time.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we look at 
an ALTernative with the FUNCTION keys…

Keystroke What it does

ALT + F1 Insert Chart as an object

ALT + F2 Save As

ALT + F4 Close application

ALT + F5 Refresh

ALT + F6 Switch to VBA Integrated Development Environment (IDE) (if open already)

ALT + F8 Run macro

ALT + F11 Show VBA Integrated Development Environment (IDE)
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 14 - 16 Dec 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties. To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course. 

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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